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1.  Introduction to CPRS

What is CPRS?
The Computerized Patient Record System (CPRS) V. 1.0 is a Veterans Health
Information Systems and Technology Architecture (VISTA) product that presents
a comprehensive view of a patient’s clinical information in an action-oriented
environment. CPRS integrates Adverse Reaction Tracking, Bed Control, Consults,
Dietetics, Encounter Forms, Order Check Expert System, Inpatient Pharmacy,
Laboratory, Order Entry, Outpatient Pharmacy, Problem List, Radiology/Nuclear
Medicine, Registration, Scheduling, Text Integration Utilities, and Vitals. It
organizes and presents all relevant data on a patient in a way that directly supports
clinical decision-making. This data includes medical history and conditions,
problems and diagnoses, diagnostic and therapeutic procedures, and interventions.

Features
• Time-delay capability for pre-admission, discharge, and transfer orders
• Complete Order Sets that can be pre-defined and personalized
• Order checking
• Orders integrated with progress notes, results, procedures, diagnosis, and

Problem List
• Patient/Provider linkage
• Consistent, event-driven, windows-style clinical user interface

 
 
 Intranet WWW Documentation
 
 Documentation for this product is available on the intranet (World Wide Web) at
the following address:
 
 http://www.vista.med.va.gov/softserv/clin_bro.ad/cprs/index.html
 
 GUI and Windows
 GUI stands for Graphic User Interface, most frequently seen as Windows or the
Macintosh screen. If you have already used programs with these screens, then the
CPRS GUI screen will seem familiar to you. The CPRS GUI is only implemented
on the Microsoft Windows platform at this time.
 
 If you have little or no familiarity with Windows, you can browse through the
Windows help file for information about the basics of using Windows. Also, see
the next few pages for brief descriptions of some GUI features.
 
 To access the Windows Help File, click the Start button in the taskbar and click
Help. Use this help file as a reference whenever you have general questions about
Windows. You can also select this file from the Tools menu in CPRS.
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 Introduction, cont’d
 

 Windows
 An “application window” is the area on your computer screen used by a program.
If you have more than one program running at the same time, you can go from one
program to another by clicking in each application window. You can also move,
close, or minimize the application window to make room for another window. (See
Help in Windows for further instructions on these functions.)
 
 Pop-up Windows
 These are “mini” windows that pop up within a window to provide or request
information. Usually they require some action before they will go away. Clicking
on buttons with the words <Accept>, <Cancel>, <Exit>, or something similar
closes these windows.
 
 Menus
 Menus are shown in the gray bar near the top of the window. They are File, Edit,
View, Tools, and Help — typical menus for most Windows applications. When
you click on one of these, a list of options is displayed.
 
 Tabs
 CPRS tabs, placed across the bottom of the screen, represent the
different components of a Patient Chart. When you click on one of
these, a new window opens, with information and available actions for
that subject. These tab windows are described in the following pages.
 
 
 Help
 Online help and documentation are available in several formats: context-sensitive
help, Windows menu help, Internet Web documentation, CD-Rom tutorials, etc.
 

 Context-sensitive Help
 Use the F1 convention commonly used in Windows 95 applications to
get help on screen elements (menus, names, labels, boxes). 

 Menu Help
 Select the Help Menu at the top of the screen. A Table of Contents opens.
Choose one of the contents, or type in a topic you want help on. A screen
appears containing help about that subject.
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 2. Starting CPRS
 

 Opening a patient record
 
 1.  Click the icon for CPRS.
 2. Select CPRS or the name of the Server from the “Connect To” box (press the down-

arrow on the List Box at the top, then select from the List that appears). Then click on
the OK button.

 3.  Enter your Access and Verify codes in the next screen that appears.
 Tab between the Access and Verify boxes (don't press Enter or Return).
 4.  Press the OK button.
 

 Shortcut: Enter access code, semicolon (;), and verify code in the access code box.
     (Example: ab1234;cd5678<Enter>)
 
 
 Selecting a Patient

 
 After you sign into CPRS, you see the Patient Selection screen.
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 Selecting a Patient, cont’d
 
 1. In the Patient Selection screen, select the category in which you want to search for a

patient's record by clicking the radio button in front of the category (Default, Providers,
Teams, Specialties, Clinics, Wards, or All).

 
 2.In the list box below the radio button, click the item that narrows the search further (such

as a specific ward).
 
 If you select something other than the default, CPRS sorts the patient list and divides the

list into two parts: Above the line are the names for the category and item you selected;
below is a comprehensive list.

 
 3.In the list box in the center of the screen, locate the patient's name (scrolling if necessary)

and click it once.
 
 When you click a name, the patient's full name, social security number, and other

information appear on the right side of the dialog.
 
 4. You can also enter the patient’s name in any of the traditional VISTA formats (e.g., last

initial and first four digits of the SSN).
 
 5.Verify that you have selected the correct patient. If you have the correct patient, click OK.

If the patient displayed is not the correct patient, repeats steps 3 and 4 until you find the
right patient and then click OK.

 
 6.When you click OK, CPRS opens to the Cover Sheet.
 
 

 Notifications
 
 Clinical Notifications are displayed on the bottom of the patient selection screen. Only
notifications for your patients are shown. You or your clinical coordinator can set personal
preferences or site parameters to determine what notifications you receive.
 
 1. Double-click on a displayed notification to review it.
 2.  To take action on one or more notifications:

• Click the Select Info button to read and delete Information notifications (items
preceded by an “I.”

• Click one or more notifications, then click on the Process button; you’ll be able to
process each notification sequentially.

• Click the Select All button, then the Process button. Each notification will be
presented to you sequentially for you to review and take action on.

• Click the Forward button if you want to send the notification to someone else.

1.  
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3.  Cover Sheet

The CPRS Cover Sheet provides an overview and summary of a patient’s medical record.
Click on any item to get more detailed information.  Features of the Cover Sheet are described
below.

Menus
Click on any of the following menu names on the menu bar to see more actions you can take. These
menu items change according to the window you’re in (e.g., Problems, Orders, Notes, etc.)

File You can select a new patient, update the provider or location, review/sign
changes, or exit.

Edit Depending on the context, you can copy, cut, paste, or change
Preferences.

View You can change the date range or other parameters to focus the screen
items.

Action This menu contains actions you can take on orders, notes, problems, etc.
Tools This menu can contain links to other non-CPRS software or online (e.g.,

internet) information or tools.
Help Online help about using CPRS is available by clicking on this menu.

Menu Bar

Patient ID box

Provider/
Encounter box

Postings
(CWAD)

    Tabs
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Cover Sheet, cont’d

Patient ID Box
Information about this patient is displayed when you click on it. You can also select a new
patient by clicking on this box.

Provider/Encounter box
This box shows the location and primary provider for this patient. You can change any of
the encounter/visit information by clicking on the box.

Patient Postings
These are Crisis Notes, Warnings, Adverse Reactions, and Directives (CWAD), usually
recorded through the Progress Notes portion of Text Integration Utilities (TIU).

Tabs
To move to other sections of the chart, click on the tab for that section (e.g.,
Problems, Notes, or Labs).

Clinical Reminders
Clinical Reminders, introduced with Patient Care Encounter v1.0 (PCE), may be used to track
and improve preventive health care for patients, by electronically reminding VA practitioners
that specific actions such as examinations, immunizations, and mammograms should be
performed by the clinician. A reminders definition uses a patient’s age, sex, and medical
history when evaluating when care was last given, when it is due next, and specific details
about why the patient should or should not receive the care. Reminders can be defined to
apply to all patients or to patients who have specific clinical findings.
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4. Electronic Signature

An electronic signature is the private code that an authorized user types into the system after
performing certain actions. For CPRS, it’s used by clinicians entering orders. This signature has
the same validity as the written signature on the chart.

Implementing electronic signature for CPRS is a three-step process:

1.  The user must be defined as a provider in the NEW PERSON file.
2.  The ORES key is assigned to users who have signature authority.
3.  Users give themselves electronic signature codes.

F  NOTE:  Until ORES key holders have an electronic signature code, the system assumes that
orders entered have been entered and manually signed “on chart”; orders are automatically
released to the ancillary service for action.

Once ORES key holders have an electronic signature code, they will be prompted to enter the
electronic signature after accepting the orders. If the electronic signature code is entered
correctly, the orders are released to the services for action. If the electronic signature code is not
entered, or is entered incorrectly, the orders are not released to the services for action, but are
held in an unreleased/unsigned status. Key holders are given three chances to correctly enter
their signature codes.

You may also sign orders before you leave the chart by selecting Sign from the Action menu or
Review/Sign Orders from the File menu.

Electronic Signature Edit option

Key holders may enter or edit their electronic signature codes through the option, “Electronic
Signature Edit,” on the User’s Toolbox menu. To change an existing code, the user must type in
the current code and then enter the new one.

Review and Sign, per signature status, works as follows:

User has provider key only (med student): If there are notes the user can sign, the ES panel
appears in Review/Sign Changes; otherwise it is hidden. Orders appear on the list with the
checkbox greyed. If the ES is entered for documents, it is NOT applied to the orders.

User has OREMAS key: If users (clerks) have entered notes for which they are the author AND
orders on behalf of a provider, TWO review screens will appear one prompting for ES for the
things the clerk can sign (a note), and one to allow the clerk to process the orders (mark signed
on chart).

User has ORELSE key: Works the same as for clerks, but the user can also release the orders.

User has ORES key: Sees the review screen with the ES prompting, both for notes and orders.
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5. Problems

The Problem List is used to document and track a patient’s problems. It provides you
with a current and historical view of the patient’s health care problems across clinical
specialties. It allows each identified problem to be traceable through the VISTA
system in terms of treatment, test results, and outcome.

When you select the Problem tab, the patient’s active problems are listed in the right-
hand box. You can display inactive problems only, both active and inactive problems,
and problems for a selected service or provider by changing your view through the
View menu. You can add, change, inactivate, remove, verify, or annotate problems.

To add a new problem to a patient's problem list:

1. Click on the New Problem button.

2. Enter information about the problem in the dialog box that appears.

3. If you don’t have a category of problems defined (see Problem List documentation),
a Lexicon box pops up for a term to be entered and searched on.

4. Close the dialog box when finished. The problem will be shown on the Problem List
in the right-hand box.
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6.  Meds

When you select the Meds tab, you can review both Outpatient and Inpatient
Medications. The expiration date and refills remaining are shown for Outpatient
Medications. You can change your display to show narrower views, such as
specific statuses. You can also get a more detailed display of each order. You can
order new medications by selecting New Medication from the Action menu or by
going to the Orders tab.

The default order in which meds are displayed is by status, with active orders at the
top.

View Choices:
• Active Medications Expiring Medications
• Sort by VA Drug Class Sort by Drug Name
• Details

 
 Actions allowed:
• Change Hold
• Renew New Medication
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 7.  Orders
 

 When you click on the Orders tab at the bottom of the screen, you see a screen
containing current orders for the selected patient.

 
 In the box on the left are names of services or categories you can place orders for.
Select one of these and an ordering dialog box appears on the lower half of the
orders screen. As you specify conditions of the order, the order and its details
appear in the orders screen above. See the section "Customizing CPRS" on page
26 for instructions on Customizing your order list.
 

 
 NOTE: A + in front of a lab order indicates multiple times were selected for a test

under How Often,.
 

 Order Checking
 Order checking, a component of order entry, is based on a system of rules, which review
orders to see if they meet defined criteria. If they meet the criteria, an electronic message is
sent to the ordering provider before the order is completed (such as duplicate order, drug-
lab interaction, etc.). The provider can then choose to cancel the order or override the order
check and place the order.
 

 FF  NOTE: All order checks are exported disabled at the system level. When IRMS turns them
on at the system level, they are then turned on for everyone. IRMS, Clinical Coordinators,
individuals, or services can then disable individual order checks if they choose to.



04/26/99 CPRS V 1.0 Clinician Guide 14

 
 
 
 
 
 
 Order Checking, cont’d
 Order Checking performs checks while ordering is taking place. Before orders go to
services such as Lab and Pharmacy, they are sent to Order Checking where the ordered
item is evaluated by an expert system rule against data from patient files. If one or more of
the designated rules of logic for that type of order is met, order check messages are
presented to the clinician placing the order.
 
 Order checks exported with CPRS
    ALLERGY-CONTRAST MEDIA INTERACTION
    ALLERGY-DRUG INTERACTION
    AMINOGLYCOSIDE ORDERED
    BIOCHEM ABNORMALITY FOR CONTRAST MEDIA
    CLOZAPINE APPROPRIATENESS
    CT & MRI PHYSICAL LIMITATIONS
    DISPENSE DRUG NOT SELECTED
    DRUG-DRUG INTERACTION
    DUPLICATE DRUG CLASS ORDER
    DUPLICATE DRUG ORDER
    DUPLICATE ORDER (Non-Med)
    ERROR MESSAGE
    ESTIMATED CREATININE CLEARANCE
    GLUCOPHAGE-CONTRAST MEDIA
    LAB ORDER FREQ RESTRICTIONS
    MISSING LAB TESTS FOR ANGIOGRAM PROCEDURE
    ORDER CHECKING NOT AVAILABLE
    POLYPHARMACY
    RECENT BARIUM STUDY
    RECENT ORAL CHOLECYSTOGRAM
    RENAL FUNCTIONS OVER AGE 65

 

Quick Orders
Some commonly ordered items have been set up so that you don’t have to fill in any  details or
conditions about the order; you simply click on the order name and the rest is automatically
completed for you. You can create quick orders for yourself by choosing Save as Quick Order
from the Options menu, after you have gone through the process of placing an order the normal
way by filling in all the boxes.

 

 Order Sets
 Order sets are comprised of a group of related quick orders. The purpose is to minimize
the number of prompts to answer for a common protocol or set of orders.
 See the CPRS Set-Up Guide for instructions about creating order sets. If your site has
created order sets (e.g., for admission orders, pre-op orders, etc.), you can select one from
the Add Orders screen.
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"Add New Orders"
 Your site may set up a screen of orderable items similar to the OE/RR 2.5 Add New
Orders screen. If this is called Add New Orders, select this from the Write Orders box.
You will then see a screen similar to following, depending on what your site has set up.
Items with arrows in front of them are Quick Orders.
 

 

Signing Orders
 When you exit the patient chart, you are prompted to sign your orders. You may exit and
sign later, if necessary. You may also sign orders before you leave the chart by selecting
Sign from the Action menu or Review/Sign Orders from the File menu.

 F   NOTE:  if you are not set up for electronic signature, see the Electronic Signature section
earlier in this guide or check with your clinical coordinator.
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Order Actions
Action Description
Change Inpatient Medications allows editing of orders while they are

still pending.  Other service/sections require the old order to be
“DC’d” (cancelled) and a new order to be added, if the original
was incorrect. Changed orders appear on the Review Screen as
DC’d orders, along with the new order.

Copy to New
Order

This is a shortcut that allows you to copy an order, rather than
having to completely write a new order. This action is useful
for when hospital policy requires that new orders be written
periodically, or when orders are discontinued for ward
transfers.

Renew If allowed by the service (usually only Pharmacy), you can
renew/reinstate order(s) that have been discontinued.

Discontinue/
Cancel

Lets you discontinue orders that haven’t been released to the
service yet or that hasn’t expired yet. After you request that an
order be discontinued, you must electronically sign it or indicate
that it’s been signed on the chart. It will then show up on the
“New/Unsigned Orders” screen as a discontinued order. If an
order is discontinued by the service, a notification will be
triggered that the order (for discontinuation) requires a chart
signature.

Hold You can place an Order on hold, preventing further processing
until "unhold" action or expiration of order.  Not all packages
may allow their orders to be placed on hold; Pharmacy orders
may be placed on hold, but Lab orders can’t.

Release Hold This action allows an order to continue its processing.
Renew Some orders can be renewed using this action.
Alert When
Results

Allows you to be alerted when  results are available for an
order.

Flag This action lets you place a notice that the order needs
clarification or further instructions.

Unflag Takes the flag off after clarification or instructions are
received.

Ward Comments You can add ward comments about an order; these will be
displayed on the Details screen.

Sign Selected This lets you sign an order electronically by entering your
electronic signature code, or indicate that the order was signed
on-chart.
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 Order Views

 
View Description
Chart Tab If you select Chart Tab, you are given a list of the tab you'd

like to change to. This is an alternate way from selecting the
tabs at the bottom of the screen.

Active Orders You can change your view to only display active orders.

Expiring Orders Only expiring orders will be displayed when you select this
view.

Unsigned Orders Only unsigned orders will be displayed when you select this
view.

Custom Order
List

This allows you to create a customized list based on dates and
types of orders.

Details More information about the selected order is displayed.

Results Allows you to view results for an order.
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 Orders by Service/Type
 Patient Movement
 You can order patient movements  Admit, Transfer, Discharge, and Treating Specialty
changes with this order type.

 
 

 Activity/Nursing Orders /Free Text Orders
 Parameters, Activity, Patient Care, and Free Text orders are different kinds of orders that
are placed for nursing and ward staff to take action on. They print only at the patient’s
ward/ location, and are not transmitted electronically to be completed by other
Services.
 
 
 Consult or Procedure Orders
 You can order consults and make procedure requests from the Orders tab or from the
Consults tab.
 1. Select the Service/Specialty from the All Services hierarchy displayed in the left panel.
 2. Fill in the following boxes (required unless stated as optional):

 Reason for Consult
 Inpatient or Outpatient
 Urgency
 Place of Consultation
 Attention (optional; this is the person the consult is directed to in the service you selected.)
 Provisional Diagnosis (optional)

 3.  Click on the Accept Order or Quit button. If you click on Quit, it will ask if you want to
accept the order. If you accept the order, it is added to the list of orders, and you will be
prompted to sign when you leave the patient’s chart.

 4.  You can perform other actions, such as hold, discontinue/cancel,
 
 
 Diets
 This option allows the entry of any of the following:
 Diet Order Additional Orders
 NPO NPO Now
 Early/Late Tray NPO at Midnight
 Tubefeeding Isolation/Precautions
 

 Imaging
 1. Select an imaging type (General Radiology, CT Scan, MRI, Nuclear Medicine,

etc.) from the selection box. The ordering dialog box then appears.
 2. Select Modifiers, exam date, History & Reason for Exam, etc. All required

fields must be filled in. If one is left unanswered, you'll receive a message.
 3. Click on Accept Order.
 
 



04/26/99 CPRS V 1.0 Clinician Guide 19

 

 Orders, cont’d
 

 Lab
 1.  Select Lab Tests from the Write Orders panel.
 2.  Select one of the available lab tests.

 You can order many tests as quick orders (i.e., you don’t have to enter
collection times, urgencies, or other conditions), depending on what your site
has set up.

 3.  If this isn’t a quick order, type the name or select one of the choices from the
scroll-down box for Collect Sample, Specimen, Urgency, Collection time,  and
How Often. NOTE: If you select multiple times for a test under How Often, a
+ will appear in front of this test on the Orders screen.

 4. If patient will be sent to the lab, click this button.
 5. Click the Accept Orders or Quit button.

 

 Outpatient Meds
 You can order Meds either through the Orders tab or the Meds tab.
 1.  Select Meds, Outpatient from the Write Orders column.
 2.  Type in the medication name.
 3.  Select the medication formulation from the box below.
 4.  Choose the dispense drug.

 

 ++ NOTE: Dispense drug is optional, but for Order Checking to occur, it must be entered.
 

 5.   Enter instructions by typing in the number of units to be taken.
 6.   Enter Route. (Automatically defaults to the common route for this drug).
 7.   Enter Schedule (optional). Answer this prompt only if the prescription dose or duration

in limited to a certain number of days and will not be renewed or otherwise continued,
e.g., ascending/ descending dosages and time-limited meds such as antibiotics.

 8.   Enter the dispense Quantity needed. For Discharge medications, calculate the units to be
dispensed (one month’s supply if no duration). For a Pass, type in the exact number,
based on duration.

 9.   Enter Refills. This prompt must be answered. Enter 0 if no refills are desired.
 10. Enter the method of delivery (WINDOW (automatic default), clinic or mail).
 11. Click on the Accept Order or Quit buttons. You will be prompted to sign when you exit

the patient chart.

 

 Inpatient Meds
 1. Select Meds, Inpatient from the Write Orders column.
 2. Type in the medication name.
 3. Select the medication formulation.
 4. Choose the dispense drug.
 5.  Type in the total dosage desired using Uppercase, e.g., 325MG.
 6.  Enter Route. (Automatically defaults to the common route for this drug).
 7.  Enter schedule, e.g., QID. Now select the routine administration times for the schedule,

e.g., 9a-1p-5p-9p. Use caution when entering schedule. Use ALL uppercase, Use H for
hour(s), and leave a space between time and PRN, e.g., Q4-6H PRN.

 8.  Type in provider comments, if any, e.g.,  X 7 days, or special instructions.
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 Orders, cont’d
 Inpatient Meds, cont'd

 
 9.  Click on the Accept Order or Quit buttons. You will be prompted to sign when you exit

the patient chart.
 

 ++ Hint: Separate orders are required for meds with different dosages, such as 2 MG AM and 4
MG HS.

 

 

 Patient Care Orders
 Patient Care orders are another kind of Nursing free-text orders for ward staff.
These print only at the patient’s ward/location. Patient Care orders include skin
and wound care, drains, oxygen therapy, etc. Pre-defined nursing orders (quick
orders) are available under various sub-menus. Nursing orders may also be
composed by selecting the Text Only option from the Add Order Screen (AD).
These orders require the unit staff to take action to complete the request. No other
departments receive these orders.
 

 Vitals
 Vitals can be ordered from the Vitals box on the Cover Sheet or from the Orders tab.
 You can order all of the normal Nursing Vital Measurements, including height, weight, blood
pressure, pulse, etc.
 
 To order Vitals:
 1. Select Vitals from the Write Orders column.
 2. Select the kind of measurement you wish from the list in the ordering dialog box.
 3. Enter the schedule, a start time, and a stop time. When you select the stop time button, a
calendar appears for you to check on.
 4. Enter additional instructions, if desired.
 5. Click on the Accept button.
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 8.  Notes
 

 When you select the Notes tab, you can view a Progress Note for a selected date.
 

• If you wish to write a new progress note, click on the New Note button.
 

 
• Boilerplate (template) capabilities, such as SOAP (subjective, objective, assessment,

and plan), are available to help you create progress notes more readily. You can also
use embedded objects to bring in information from other VISTA programs. In addition,
you can cut and paste from lab results, the Problem List, or other online information,
to complete your Notes.

 
• If you are writing a note for an outpatient visit, an Encounter Form screen appears,

which lets you enter all the required data (Provider, diagnosis, procedure, etc.) for
patient visits. This is linked to TIU (Text Integration Utilities) and the Ambulatory
Care Data Capture programs, so that information entered here provides workload
credit.

FF  NOTE: You can’t file encounter data on inpatients; that’s why the encounter
button is grayed out for inpatients.

Progress Notes is a component of TIU, which can be accessed for individual patients through
CPRS, or for multiple patients through the TIU interface.
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9. Consults

The Consult/Request Tracking package provides an efficient mechanism for clinicians to
order consults and procedures. It also allows hospital services to update and track the
progress of a consult/procedure request from the point of receipt through its final
resolution. This reporting includes doctor's notes and comments entered by other care
providers involved with the request. The Consults package is closely integrated with
CPRS, so that as the orders are processed through to completion, the status of the orders is
updated on CPRS review screens and comments are viewable from CPRS. Also, most
consults actions are available from the CPRS Consults tab. The request and results then
become part of the patient's computerized medical record.

Many Consults actions must be performed through the TIU or Consults/Request Tracking
programs (in List Manager). For example, occasionally a consult result is linked to the
wrong consult. Information on how to make corrections on these, as well as detailed
instructions on all Consults actions is contained in the Consult/Request Tracking
documentation.

Consult ordering screen:
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10. D/C Summaries

Discharge Summaries entered through TIU can be displayed, edited, and signed
through CPRS. If you wish to work with more than one patient’s summary, you
must go through the TIU interface in List Manager.

1. Click on the D/C Summaries tab. The Discharge Summary screen appears.
2. Select a discharge summary from the list in the panel on the left of the screen

(if any discharge summaries have been entered for this patient).
3. or Click the New Summary button to write a new discharge summary.
4. If you wish to edit, save, or sign this discharge summary, select an action from

the Action menu.

See TIU documentation for more information about Discharge Summaries.
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11. Labs

You can display lab results in many ways:

• by time ranges
• by specific components of lab (chemistry, microbiology, etc.)
• by cumulative or interim reports
• by worksheets
• by graphs
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 12. Reports
 

 Many reports are available through CPRS, including
 
• Health Summaries,
• Imaging
• Blood Bank Report
• Anatomic Path Report
• Dietetics Profile
• Nutritional Assessment
• Vitals Cumulative
• Procedures
 
 These can be printed on your screen or at printers designated by your site.
 If you choose Health Summary, you can then specify a Type that you have defined
at your site.

 
 
 
 
 For more information about printer set-ups (or other print issues) and customizing
reports, see your clinical coordinator.
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 13. Customizing CPRS
 

 CPRS provides several ways to customize it to your needs:
 
• Order List
• Patient selection defaults
• Personal and patient team lists
• Print formats
• Notifications
• Font size on screens
• Lab order displays
• Lab results displays
• Order checks
• Quick orders
• Tools menu
 
 Custom Order List

 By default, CPRS shows all active, pending, unreleased, ed/edit, and renewed orders for all
services. You can customize the order list to show you particular kinds of orders.

 You can customize your view of the list by choosing any of the following criteria.:

• A grouper or individual service (Grouper services have other services underneath them
and your selection will include all of those services if the grouper is selected.)

• The order type (such as all, active, pending, unsigned, expiring, unverified by clerk,
and so on)

• Chronological order (with the most recent order first)
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Custom Order List, cont'd

To create a custom order list for the selected patient, follow these steps:

1. Click the Orders tab.
2. Select View | Custom Order List....
3. In the Custom Order View dialog, click the desired grouper or individual service.
4. Click the desired type of order.
5. Choose whether you want the entries in reverse chronological sequence.
6. Choose whether you want the orders grouped by service.
7. Click OK.

 Personal Preferences
 You can change many of the parameters that control the way CPRS works for you. The
Personal Preferences Menu on your Clinician Menu (in List Manager) contains sub-menus
that allow you to change
• notifications and order checking messages you receive
• team or personal lists
• default patient names to appear automatically when you open CPRS.

 
 Disable a Notification Example
 You can disable any notification that isn’t designated as mandatory by your site.
 
 Select Personal Preferences Option: NO  Notification Mgmt Menu
 
    1      Enable/Disable My Notifications
    2      Erase All of My Notifications
    3      Set Notification Display Sort Method (GUI)
    4      Send me a MailMan bulletin for Flagged Orders
    5      Show Me the Notifications I Can Receive
    6      Set Surrogate to Receive My Notifications
 
 You have PENDING ALERTS
           Enter  "VA   VIEW ALERTS     to review alerts
 
 Select Notification Mgmt Menu Option: 1  Enable/Disable My Notifications
 
                         Enable/Disable My Notifications
 -------------------------------------------------------------------------
 
 ---------------------- Setting   for User: GREEN,JOANN ------------------
 Select Notification: LAB RESULTS
 Are you adding LAB RESULTS as a new Notification? Yes// <Enter>  YES
 
 Notification: LAB RESULTS// <Enter>  LAB RESULTS   LAB RESULTS
 
 Value: Disabled
 Select Notification: <Enter>
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 Customizing CPRS, cont’d
 
 
 Team lists
 A team list is a list containing patients related to several providers. These providers are the
list’s users. You may create a new team list or add autolinks, users, or patients to an
existing team list. Autolinks automatically add or remove patients with ADT movements.
Users on the list may receive notifications regarding patients on the same list. Please prefix
your list name with TEAM or SERVICE (e.g. TEAM7B, SERVICECARDIOLOGY.)
 
 Tools Menu
 You can have your clinical coordinator add non-VISTA items to this menu. Word
processors, Outlines in Clinical Medicine, or other clinical guidelines documents,
spreadsheets, etc. are all possible additions, for ready access to useful tools for your
clinical practice.
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 14.  Helpful Hints
 

 Q: How can I get immediate help about something I’m trying to do in CPRS?
 A:  You can go to the Help menu and select a topic from the Table of Contents or Index.

You can also right-click on your mouse on most screens and a window appears that
contains available actions and also “What’s this?” which provides help when you click
on it. (Soon, you’ll be able to select the F4 key, then position the ? on a screen
element, and a pop-up window will provide instructions.

 
 Q: How do I activate an order?
 A:  After completing all the steps for ordering, click the Accept Order button. Some orders

require signatures or verification before they can be acted upon.
 
 Q: How do I sign an order?
 A:  You can sign an order immediately after placing it, after placing all orders for a

particular service, or after you have placed all orders during a working session.
 

• To sign after all lab orders are entered (or meds, diets, or imaging), select “Sign”
from the Action menu (at the top of the screen or by clicking the right button on
your mouse).

 
• To sign after entering all orders, simply click the Accept Orders button after each

set of orders for different services, then when you exit the patient’s chart, a pop-up
window will ask you to enter your electronic signature or save the order to be
signed later (a notification will be created for unsigned orders).

Q: How do I turn off notifications I don’t want to see?
A:  You can turn off many notifications through your Personal Preferences menu (in List

Manager). Most notifications are determined by teams you belong to or by your
VAMC policies. Check with your clinical coordinator if you’re receiving notifications
(or order checks) you don’t believe you should be receiving and that you can’t turn off
yourself.

Q:  How do I find a progress note I wrote a year ago?
A:  From the View Menu, pick Signed Notes by Author or Signed Notes by

Date Range. When a pop-up box appears, enter the desired date range,
then enter the desired order (ascending or descending).

Q:  Where do you enter comments on an order?
A:  You can add them under Ward Comments (on the Action menu), under the Flag action, or in a

Notification.
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15.  Glossary

+ (plus sign)
A plus sign in front of a lab order indicates that the test will be performed multiple times, as
selected in the "How Often" box.

ASU
Authorization/Subscription Utility, a VISTA package (initially released with TIU) that allows
VAMCs to assign privileges such as who can do what in ordering, signing, releasing orders, etc.

Clinical Reminders
Clinical Reminders, introduced with Patient Care Encounter v1.0 (PCE), may be used to track and
improve preventive health care for patients, by electronically reminding VA practitioners that
specific actions such as examinations, immunizations, and mammograms should be performed by
the clinician. A reminders definition uses a patient’s age, sex, and medical history when evaluating
when care was last given, when it is due next, and specific details about why the patient should or
should not receive the care. Reminders can be defined to apply to all patients or to patients who
have specific clinical findings. For example, the influenza vaccine is generally given to patients
who are 65 or older. However, some patients fall into high-risk categories and should be given the
vaccine at any age. The details of a reminder describe why the patient is at high risk and should be
given the vaccine.

PCE exported 40 pre-defined Clinical Reminders, including Diabetic Foot Examination, Seat Belt
Education, Influenza Vaccine, Fecal Occult Blood Test, Cholesterol Screen, Tobacco Cessation
Education, and Alcohol Abuse Education. In addition to the pre-defined clinical reminders,
facilities may create site-specific clinical reminders based on preferences specified by clinic,
provider, facility, and VISN.

With the emphasis on preventive care, Clinical Reminders are used to comply with requirements
established for VISN directors’ performance criteria, clinical practice guidelines, and national
standards such as those defined by the VA’s National Center for Health Promotion and JCAHO
accreditation evaluations.

Consults
Consult/Request Tracking, a VISTA package commonly known as Consults, is a
component of CPRS. Consults can function as part of CPRS, independently as a
stand-alone package (for management purposes only), or as part of TIU.

Cover Sheet
The CPRS patient chart screen that displays an overview of the patient’s record,
with tabs at the bottom representing components of a patient’s chart.

CPRS
Computerized Patient Record System, the VISTA package (in both GUI and
character-based formats) that provides access to most components of the patient
chart.
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Glossary, cont’d

CWAD
CWAD, also known as Postings, is a component of the CPRS that presents
information on Crises, Warnings, Adverse Reactions, or Advance Directives about a
patient.

D/C Summaries
Discharge Summaries are a component of the patient chart and also part of TIU.

GUI
Graphical User Interface—a Windows-like screen that uses pull-down menus, icons,
pointer devices, and other metaphor-type elements that can make a computer
program more understandable, easier to use, allow multi-processing (more than one
window or process available at once), etc.

Health Summary
A VISTA package that pulls selected components of data from other VISTA
packages to present a summary of a patient’s health care, including clinical
reminders. It can be viewed through CPRS reports.

Imaging
A VISTA program and a component of the patient chart that includes Radiology
procedures, X-rays, and Nuclear Medicine. Also refers to the VISTA Imaging
package, a program that can graphically display various tests and procedures.

Notifications
Notifications are a specialized kind of alert regarding patients or a patient’s orders.
These appear on the CPRS patient selection screen and can be acted upon from
there. They can be tied to team patient lists.

OE/RR
Order Entry/Results Reporting, a VISTA package that evolved into the more
comprehensive CPRS.

Postings
A component of the patient chart that includes critical messages about a patient; an
expanded version of CWAD (see above).

Progress Notes
A component of TIU which functions as part of CPRS. Progress Notes are clinicians’
textual records of a patient’s status at the time of an encounter.

Reports
A component of the patient chart that includes health summaries, action profiles,
and other summarized reports of patient care.

TIU
Text Integration Utilities; a VISTA package for document handling, that includes
Consults, Discharge Summary, and Progress Notes, and sometimes other document
types such as surgical op reports. TIU components can be accessed for individual
patients through the CPRS, or for multiple patients through the TIU interface.
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Glossary, cont’d

VISTA
Veterans Health Information Systems and Technology Architecture, formerly
known as DHCP, the comprehensive, integrated computer system used in the VA
Medical Centers.

VA and VISTA Acronyms

Acronym Meaning

AAC Austin Automation Center

AACS Automated Allocation & Control System

AC Ambulatory Care

ACG Ambulatory Care Group (from Provider Profiling Project – VISN 20)

ACIS Ambulatory Care Information System (formerly PACE)

ACOS American College of Surgeons

ACRP Ambulatory Care Reporting Project

ADP Automated Data Processing

ADPAC Automated Data Processing Application Coordinator

AEMS Automated Medical Equipment Reporting System (Engineering)

AICS Automated Information Collection System v.3.0

AMIA American Medical Informatics Association

AMIE Automated Medical Information Exchange

AMIS Automated Management Information System

ANSI American National Standards Institute

ANSOS a Nursing Scheduling COTS

AP Anatomic Pathology

API Application Programming Interface

AR Accounts Receivable

ART Adverse Reaction Tracking V. 4.0, formerly Allergy Tracking System

AR/WS Automatic Replenishment/Ward Stock (a Pharmacy module)

ASI Addictive Substance Interview

ASU Authorization/Subscription Utility

BBS Bulletin Board System

BDK Broker Development Kit

BEST Business Enterprise Solutions & Technologies Service

C&P Compensation & Pension

CAC Clinical Application Coordinator

CAIRO Center for Applied Research and Operations

CALM Centralized Accounting for Local Mgmt (replaced by FMS)

CAT Computerized Axial Tomography

CBOC Community Based Outpatient Clinics

CIO Chief Information Officer

CIOFO Chief Information Office Field Office

CIRN Clinical Information Resources Network
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Acronym Meaning

CMOP Consolidated Mail Outpatient Pharmacy

CMR Consolidated Memorandum of Receipt Official (new official for IFCAP
w/Eqpmt Turn-In/Request Module)

COD Clinical Objects Dictionary (w/b nat'l VHA std vocab for clin concepts)

COS Chief of Staff

COTS Commercial Off-the-shelf products

CPRS Computerized Patient Record System - formerly OE/RR

CPT Current Procedural Terminology

CPU Central Processing Unit

DEA Drug Enforcement Agency

DHCP Decentralized Hospital Computer Program
Dynamic Host Control/Configuration/Communication Protocol

D&PPM Drug and Pharmaceutical Products Mgmt V. 2.0

DLL Dynamic Link Library (file)

DMMS Decentralized Medical Management System

DNS Domain Name Service (for locating Internet addresses)

DOB Date of Birth

DoD Department of Defense

DOD Date of Death

DOM VA Domiciliary

DPC Austin Data Processing Center

DSM Digital Standard MUMPS

DSM-IV Diagnostic & Statistical Manual of Mental Disorders, 4th edition

DSS Decision Support System

DSS Document Storage Systems (vendor)

DUE Drug Use Evaluation

EDR Event Driven Reporting

E3R Electronic Error and Enhancement Report (on Forum)

EIS Executive Information System

EPI Emerging Pathogens Initiative

EUCLID a site-developed (Boise VAMC) computerized patient record system

FIPS Federal Information Processing Standards

FIRMAC Field Information Resource Mgmt Advisory Committee

FM VA FileMan

FMS Financial Management System

FTEE Full-time Employee Equivalent

FTP File Transfer Protocol

GAO General Accounting Office

G-CPRS Government Computerized Patient Record System, a VA, DOD, HIS
project to integrate the automated patient record

GRECC Geriatric Research, Education and Clinical Center

GUI Graphical User Interface

HBHC Hospital-Based Home Care

HCFA Health Care Financing Administration

HEC Health Eligibility Center
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Acronym Meaning

HIMSS Health Information Management System Society

HINQ Hospital INQuiry

HL7 Health Level 7, an international communications protocol. Also refers to
the VISTA infrastructure package, which facilitates use of this messaging
system.

HLLP Hybrid Lower Level Protocol

HOST Hybrid Open Systems Technology

HSR&D Health Services Research & Development

IB Integrated Billing

ICD-9 International Classification of Diseases, 9th ed.

ICR Immunology Case Registry

IDCU Integrated Data Communications Utility

IFCAP Integrated Funds Distribution, Control Point Activity

IG Inspector General

IHS Indian Health Service or Integrated Hospital System (HOST)

IP Internet Protocol

IRA Initial Request Analysis

IRM Information Resources Management

IRT Incomplete Record Tracking

IVM Income Verification Matching

JCAHO Joint Commission on Accreditation of Hospitals

KIDS Kernel Installation & Distribution System

LEDI Laboratory Electronic Data Interchange (a new module of Lab that allows
labs to send data to each other )

LOINC Logical Obsvtn Id'r Nms & Codes (standard scheme for coding Lab tests)

MAR Medical Administration Record(s)

MAS Medical Administration Service - now PIMS

MCCR Medical Care Cost Recovery

MDC M Development Committee

MediPhor Clinical workstation commercial product  - HOST

MIME Multimedia Internet Mail Extensions

MIS Medical Information Section

MISD Management Infrastructure Development (Albany, San Francisco, Wash
DC CIO Field Offices)

MIT Means Test Indication

MPD Minimal Patient Dataset

MPI Master Patient Index (was Master Veteran Record)

MRT Medical Record Technician

MRTS Messaging Routing and Translation System

MSM Micronetics Standard MUMPS (replaced by OpenM/Avanti)

MUMPS Massachusetts General Hospital Utility Multiprogramming (now M)

MVR Master Veteran Record (now Master Patient Index )

NANDA Nursing terminology coding scheme

NDF National Drug File

NLT National Laboratory Test
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Acronym Meaning

NOIS National On-line Information Sharing system

NPCDB National Patient Care Data Base

NPF New Person File

NTEO National Training & Education Office (of OCIO)

NVS National VISTA Support (formerly Customer Support), part of Customer
Services

ODBC Open Database Connectivity

OE/RR Order Entry / Results Reporting - now CPRS

OIG Office of Inspector General

OPC Outpatient Clinic

PAID Personnel & Accounting Integrated Data

PANDAS Patient Encounter Data Acquisition System

PCE Patient Care Encounter

PCHS Federal equipment purchasing contract

PCMM Primary Care Management Module

PDM Pharmacy Data Management

PDX Patient Data Exchange

PFOP Personal Funds of Patients

PGY 1-10 Medical student status defined by Academic Affairs

PIMS Patient Info Mgmt System (?) - formerly MAS (AD/R) & SD

PL Problem List

PM&R Physical Medicine & Rehabilitation Services

PMIS Patient Medication Information Sheet

PN Progress Notes

PPP Pharmacy Prescription Practices/Package

PRD Product Requirements Document

PRS Procurement of Automated Information Resources Solutions

PTF Patient Treatment File

QUIC Quality Improvement Checklist

RAM Random Access Memory

ROES Remote Order Entry System

RPC Remote Procedure Call

SCD Spinal Cord Dysfunction Registry

SISP (VHA) Strategic Information Systems Plan

SNOMED Systematized Nomenclature of Medicine

SOAP Strategic Objective Assessment Plan for patient treatment plan

SP Surgical Pathology

SQL Structured Query Language

SRS Software Requirement Specification

T&A Time and Attendance

T&L Time & Leave Unit

TCP/IP Transmission Control Protocol/Internet Protocol

TIU Text Integration Utilities

UCI User Class Identification: a computing area or account

UD Unit Dose Pharmacy
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Acronym Meaning

UI Universal Interface, replacement system for Lab's LSI)

UMLS Universal Medical Language System

UR Utilization Review

VA Department of Veterans Affairs

VACO VA Central Office (headquarters)

VADDC VA Denver Distribution Center

VALNET VA Library Network

VARO VA Regional Office

VHA Veterans Health Administration

VIC Veterans Identification Card

VISN Veterans Integrated Service Network(s)

VISTA Veterans Health Information System & Technology Architecture

VS Vital Signs

WLN Western Library Network

WWW World Wide Web

YOB Year of Birth


	Getting Started
	Revision History
	Contents
	1. Introduction to CPRS
	What is CPRS?
	Features
	Intranet WWW Documentation
	GUI and Windows
	Help

	2. Starting CPRS
	Opening a patient record
	Selecting a Patient
	Notifications

	3. Cover Sheet
	Menus
	Patient ID Box
	Provider/Encounter box
	Patient Postings
	Tabs
	Clinical Reminders

	4. Electronic Signature
	5. Problems
	6. Meds
	7. Orders
	Order Checking
	Quick Orders
	Order Sets
	Signing Orders
	Order Actions
	Order Views
	Orders by Service/Type
	Patient Movement
	Activity/Nursing Orders /Free Text Orders
	Consult or Procedure Orders
	Diets
	Imaging
	Lab
	Outpatient Meds
	Inpatient Meds
	Patient Care Orders
	Vitals


	8. Notes
	9. Consults
	10. D/C Summaries
	11. Labs
	12. Reports
	13. Customizing CPRS
	Custom Order List
	Personal Preferences
	Disable a Notification
	Team lists
	Tools Menu

	14. Helpful Hints
	15. Glossary
	VA and VISTA Acronyms


